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Important safety information
�� Removing original equipment, adding accessories or modifying your vehicle could 

affect the vehicle’s safety or make it illegal to operate in some jurisdictions. 

�� Follow all product instructions and all instructions in your vehicle owner’s manual 
regarding accessories or modifications.

�� Consult your country’s and/or state’s laws regarding operation of a vehicle with any 
accessories or modifications.

�� It is your sole responsibility to place, secure and use your Mio in a manner that will 
not cause accidents, personal injury or property damage. Always observe safe driving 
practices. 

�� Do not mount your Mio in a way that may interfere with the safe operation of the 
vehicle, the deployment of air bags or other safety equipment.

�� Do not operate your Mio while driving.

�� Before you use your Mio for the first time, familiarize yourself with your device and its 
operation.

�� On main roads, the distance to an exit calculated by your Mio may be further than 
the distance shown on road signs. Road signs show the distance to the start of an exit 
while your Mio shows the distance to the next intersection, i.e., the end of the exit 
ramp or road. To prepare to exit a road, always follow distance information on road 
signs.

�� The use of information regarding safety or speed camera locations may be subject to 
local laws in the country of use. You are responsible for checking that you can legally 
use the information in your country or in the country where the information will be 
used.

�� Do not handle your Mio while it is hot. Let the product cool, out of direct sunlight.

�� At full power, prolonged listening to your Mio via headphones or earphones can 
damage the ear of the user.

�� Do not expose your Mio to direct sunlight in an unattended vehicle for prolonged 
periods. Overheating may damage the unit.

�� To discourage theft, do not leave your Mio, mounting bracket or any cables in plain 
view in an unattended vehicle.

Precautions
Failure to adhere to these warnings and cautions may lead to death, serious injury or 
property damage. Mio disclaims all liability for installation or use of your Mio that causes 
or contributes to death, injury or property damage or that violates any law.
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About charging

�� Use only the charger supplied with your device. Use of another type of charger will 
result in malfunction and/or danger.

�� This product is intended to be supplied by a LISTED Power Unit marked with “LPS”, 
“Limited Power Source” and output rated + 5 V dc / 2.0 A”.

�� Use a specified battery in the equipment.

About the charger

�� Do not use the charger in a high moisture environment. Never touch the charger when 
your hands or feet are wet.

�� Allow adequate ventilation around the charger when using it to operate the device 
or charge the battery. Do not cover the charger with paper or other objects that will 
reduce cooling. Do not use the charger while it is inside a carrying case.

�� Connect the charger to a proper power source. The voltage requirements are found on 
the product case and/or packaging.

�� Do not use the charger if the cord becomes damaged.

�� Do not attempt to service the unit. There are no serviceable parts inside. Replace the 
unit if it is damaged or exposed to excess moisture.

About the battery

�� Use a specified battery in the equipment.

�� CAUTION: The battery can burst or explode, releasing hazardous chemicals. To reduce 
the risk of fire or burns, do not disassemble, crush, puncture, or dispose of in fire or 
water.

�� Important instructions (for service personnel only)

�� Caution: Risk of explosion if battery is replaced by an incorrect type. Dispose of 
used batteries according to the instructions.

�� Replace only with the same or equivalent type recommended by the manufacturer.

�� The battery must be recycled or disposed of properly.

�� Use the battery only in the specified equipment.

Declaration of conformity
CE

Products with the CE marking comply with Radio & Telecommunication Terminal 
Equipment Directive (R&TTE) (1999/5/EC), the Electromagnetic Compatibility Directive 
(2004/108/EC) and the Low Voltage Directive (2006/95/EC) - issued by the Commission 
of the European Community. Compliance with these directives implies conformity to the 
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following European Standards:

�� EN 55022: 2010

�� EN55024:2010

�� EN 301 489-1 V1.9.2

�� EN 301-489-3 V1.6.1

�� EN 60950-1:2006+A11:2009+A1:2010+A12:2011+A2:2013

�� EN 300 440-2 V1.4.1  

�� EN 300 440-1 V1.6.1

The manufacturer cannot be held responsible for modifications made by the User and 
the consequences thereof, which may alter the conformity of the product with the CE 
Marking. 

Hereby, Mio declares that this Mio Combo 5207 (Truck) LM is in compliance with the 
essential requirements and other relevant provisions of Directive 1999/5/EC.

WEEE

This product must not be disposed of as normal household waste, in accordance with the 
EU directive for waste electrical and electronic equipment (WEEE - 2002/96/EC). Instead, 
it should be disposed of by returning it to the point of sale, or to a municipal recycling 
collection point.
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Getting to know your Mio
❶ ❷

❸

❹❺❻

❾

❽

❼

❼

⓬

⓫

❿

Name Description

❶ Power button Turns your Mio on and off.

❷ Memory card slot 
for recording

Accepts a MicroSD card for recording. You are advised to use a 
Class 4 memory card with at least 4GB capacity.
Note: You should use separate MicroSD cards for recording and for 
regular data storage.

❸ Camera lens Make sure that no object is blocking the camera lens and no 
reflective material appears near the lens.

❹ Reset button Restarts your Mio.

❺ Speaker Sends out sounds and voice.

❻ Stylus Tap on the touch screen to make selections and enter 
information.

❼ Microphone Receives sounds.

❽ Touch screen Displays the output of your device.

❾ Charge indicator Glows in red when charging is in progress.

❿ Mini-USB connector Connects to the charger.

⓫ Memory card slot 
for data

Accepts a MicroSD card for accessing data.

⓬ Earphone jack Connects a set of earphones.
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Mounting and charging your Mio in a 
vehicle

�� Never mount your device where the driver’s field of vision is blocked.

�� If the windscreen is tinted with a reflective coating, it may be athermic and impact the 
GPS reception. In this instance, please mount your device where there is a “clear area” 
- usually just beneath the rear-view mirror.

�� To protect your device against sudden surges in current, connect the in-car charger 
only after the car engine has been started.

�� When you unplug the external power source, the device will automatically enter a 
suspended state within 10 seconds. To continue using the device, tap Yes.
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CAUTION: For optimal performance of the lithium battery:
•	 Do not charge the battery where the temperature is high (e.g. in direct sunlight).
•	 There is no need to fully discharge the battery before charging. You can charge the battery 

before it is discharged.
•	 When storing the product for a long period of time, be sure to fully charge the battery at least 

once every two weeks. Over discharge of the battery can affect the charging performance.
•	 Failure to follow the battery usage instructions could cause damage to your device, battery 

and even bodily injury or property damage and will void any warranty.
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Turning on and off
Note: The battery may not be fully charged when you use your device for the first time.

�� For the initial start-up, press and hold the power button until the device turns on.

When you turn on your device for the first time, follow the prompts to customise your 
device.
Note: The first time you use your Mio, it may take several minutes to establish a GPS 
connection. When you have a GPS fix, you can start to use your Mio to plan your trip.

�� While the device is turned ON, press the power button and it will enter a suspended 
state.

To resume using the device, do one of the following:

�� Press the power button briefly.

�� Connect the device to an external power source.

�� To turn OFF the device, press and hold the power button until the device shuts down.

CAUTION: When your Mio is turned on and connected to a computer, it is recognized as an 
external mass-storage device. Do NOT delete any files that are pre-installed on your Mio. 
Deleting the files can cause your Mio to crash.

Resetting the device
Occasionally, you may need to perform a hardware reset when your Mio stops responding; 
or appears to be “frozen” or “locked-up.” Insert a small rod, such as a straightened 
paperclip (or the stylus that is attached to the back of the device holder), into the reset 
button of your device.
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Navigating on the screen
To operate your Mio, touch the screen with your finger (or the stylus that is attached to 
the back of the device holder). You can perform the following actions:

�� Tap: Touch the screen once with your finger to open items or select onscreen buttons 
or options.

�� Drag: Hold your finger on the screen and drag up/down/left/right or across the screen. 
(This is not supported by all applications.)
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Inserting a memory card
CAUTION: 
•	 Do not apply pressure to the centre of the memory card.
•	 Do not insert or remove the memory card when the device is turned on.

Hold the card (MicroSD) by the edges and gently insert it into the slot as shown in the 
illustration.

To remove a card, gently push the top edge of the card inwards to release it, and pull it 
out of the slot.
Note: MiTAC does not guarantee the product’s compatibilities with the storage cards from all 
manufacturers.
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Main Menu
The Main Menu is your starting place for various tasks, including searching for a 
destination, viewing saved locations as My Place/Home, and searching for POIs nearby, 
and so on.

Icon Description Icon Description

Search for places, areas and streets to 
help plan your route.

Display the Map screen.

Access your saved locations. Configure your Mio to enhance your 
navigation experience.

Start recording the driving conditions 
or display the recording screen.

Explore the area around your current 
position or destination.

Add or begin a planned trip with 
multiple waypoints.

Display the calculated route in 
simulation mode.

Record GPS coordinates of a location 
or a journey.

Select your navigation mode: Car or 
Truck.

Set or navigate to your home address. Search for Points of Interest nearby.
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Navigating through the screens
�� If the Main Menu button  appears in the top-right corner of a screen, tapping it 

returns to the Main Menu immediately.

�� If the Back button  appears in the top-left corner of a screen, tapping it returns to 
the previous screen.

�� In some menu screens (such as the map Overview screen), the system provides the tab 
buttons in the title bar that allow you to enter the additional page in the menu screen. 
Simply tap the desired tab to change the view. The selected tab will be highlighted as a 
darker-colour tab.
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Navigation
Using the keyboard screen
The Keyboard screen will display when you are required to enter text, such as when 
searching for a street name. Search results will be listed in matching order, with the 
closest matches appearing on the screen. A maximum of 99 results will display.

The Keyboard screen can display with various layouts depending on the information you 
need to enter, including alphabet, number, alternate characters and combinations of 
these.

  

�� To select a character, tap the character.

�� To delete a character, tap . Tap and hold  to delete the entire text.

�� To enter numbers, tap .

�� To set the keyboard preference, from the Keyboard screen, tap . Select the 
preferred keyboard type from the list.

How do I go from A-B?

CAUTION: For your safety, enter destination information before you start a journey. Do not 
enter a destination while driving.

How do I use the FIND wizard?
Your Mio is equipped with maps that provide street-level details for door-to-door 
navigation, including Points of Interest such as accommodation, parking areas, petrol 
stations, railway stations and airports. The FIND wizard allows you to search the location 
easily.

1.	 On the Main Menu, tap .

2.	 Complete the following:
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If you want to… Then…

search for an address, tap .

search all information on the device - city, streets, named sites, 
features, landmarks or venues,

tap .

search for a city/area, tap .

search a location by postcode, tap .

search for a Point of Interest, tap .

search for a location using a GPS coordinate, tap .

search for a street intersection, tap .

navigate to a recently visited location, tap .

Note: For further instructions on searching for a POI, refer to the “How do I navigate to a 
NavPix™?” section.

How do I plan my first trip?
Using your Mio to plan your first trip is easy. There are several ways to select your 
destination. Complete the following to navigate to a street address that you know using 
the FIND address wizard.

    

    
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  

Note: When it is the first time you use FIND wizard, the Select Country screen will appear before 
the FIND screen. Select your country and then you can start searching location.
If needed, you can change the country to search location. To select the other country, tap the 
National Flag button in the title bar of the Keyboard screen before you search the city.

Complete the following:

If you want to… Then…

calculate the route and start navigating, tap .

save the location as a favourite, tap . The location will be saved in My Places 
immediately.

save the location as Home, tap   . Tap .

explore the map, tap .

How do I preview the destination on the map?
After searching an address (or a POI), you can preview the destination on map to explore 

the area near the location. On the Destination screen, tap the  button to display the 
destination preview map.

On the destination preview map, you can:

�� Tap the  /  button to zoom in/out the map.

�� View the information of your destination that is shown at the top of the Map screen.
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�� Tap on a street/area/POI to display the related information of the location near your 
destination.

�� Tap the grey arrow icon to return to your current position on the map.

�� Drag and then tap on the map to select other destinations. The information of the 
selected street/area/POI near your destination will be displayed. Tapping the check 
mark will bring up the Destination screen of the selected location.

  

How do I preview a route?
You will be able to plan a route in simulation mode that allows you to:

�� preview a route.

�� plan and view a route without a GPS fix, such as when you are inside a building.

The following steps will show you how to preview a route.

1.	 On the Main Menu, tap .

2.	 Select a departure point through the Leaving from screen.

If you have a GPS fix, you can simply select the Here button ( ) so that you do not 
need to select a departure point. Otherwise, use the FIND address wizard, Explore 
map, My Places/Recent Locations menu or Home to set the departure point if you 
want the demonstrated route to start elsewhere.

3.	 Select a destination point through the Going to screen. 

4.	 When done, tap .

5.	 The Map screen will display the calculated route in route simulation mode. The route 
demonstration will start automatically. The simulated route will be displayed as 
orange colour.

How can I plan my route using the Truck mode?
Note: The Truck mode is not available on all models and is only available in selected countries.
This feature is specifically designed for large vehicles. The Truck mode enables, with the 
input of your vehicle or trailer details, to calculate safer and more efficient routes to avoid 
the length/width/height/weight restricted tunnels and bridges, as well as sharp turns and 
narrow country lanes.
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CAUTION: Do not rely solely on this product and its features. Using this product does 
not change the requirement for a driver to take full responsibility for his behaviour. This 
responsibility includes observing all traffic rules and regulations in order to avoid accidents, 
personal injuries or property damages.

1.	 On the Main Menu, tap .

2.	 Tap Truck.

3.	 Complete the following:

If you want to… Then…

set the details for your truck, enter the following data of the truck:

�� total truck weight

�� maximum axle weight

�� total truck length

�� maximum truck width

�� maximum truck height
Note: You must complete the details of the truck settings 
before you can use the Truck mode to plan your route.

set how you want to receive the speed 
limit alerts,

tap Speed limit display / Speed limit alerts to turn it 
on or off.

limit the route planning while shipping 
hazardous materials in the truck,

tap Has Hazmat to turn it on or off.

In the Truck mode, your current position will be displayed with the  icon.

For Mio Combo 5207 LM: 

Your Mio comes with pre-activated Truck mode service for one-month free trial. You will 
be prompted to purchase (from Mio e-shop online) and re-activate the service when the 
trial period has expired.

A product key will be sent to you via email when you have subscribed. You will need to use 
this product key to activate your subscription. (For more information, refer to the “What 
is MioMore Desktop?” section.)

How do I view my route?
When a route has been calculated, the Map screen will display. You will be directed to 
your destination by spoken and visual instructions.
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







 

Item Description

 Direction and distance of next 
turn

The direction and distance to your next turn.

Tap  to repeat the vocal instruction.

 Current route Your current route is highlighted.

 Current position Your current position is marked with .

 Drive recording Tap to start recording the driving conditions or display the 
recording screen. (For more information, see the "Recording 
your driving" section.)

 Distance and time 
information

Tap to display more information.

�� DTG (Distance to Go)

�� TTG (Time to Go)

�� km/h or mph (speed) and compass heading

�� ETA (Estimated Time of Arrival)

�� Time

 Address bar The current address will be displayed in the text box at the 
bottom of the screen.

Note: Depending on your driving route, you may see some icons that provide different information 
on your Map screen. Please note that these icons will not be always displayed during your journeys.

For example: the Speed Limit icon ( ) on the Map screen. The Speed Limit icon shows the speed 
limit of the current road. If greyed out, you are below this speed limit. When over set limit, you will 
be warned with an audible and visual warning.

How do I change the route configuration?
Tap anywhere on the Map screen to bring up the Map options screen, which allows you to 
change the route-related configuration.

For more information on changing the route configuration, refer to the following sections.
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How do I view my route statistics?

1.	 From the Map options screen, tap .

2.	 Tap the tabs in the title bar to view the additional information in the different screens.

   

3.	 Your Mio provides information on your:

�� time to destination

�� distance to go

�� estimated time of arrival

�� distance travelled

�� time taken for trip

�� stationary time

�� TTD/DTG/ETA for the journey*
* Depending on the route calculated, you may see more information on the screen such as the 
estimated time/distance to the next stop when your trip contains multiple waypoints.
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How do I adjust the volume?

1.	 From the Map options screen, tap .

2.	 The volume buttons will be displayed on the Map screen in translucent mode.

Note: The volume buttons will automatically disappear after the map is idled for 5 seconds.
3.	 Complete the following:

If you want to… Then…

increase/decrease the volume, tap  /  .

The volume bar indicates the current volume level.
mute/unmute, tap .

The speaker icon indicates the status:

: muted     : unmuted

How do I zoom in/out the map?

1.	 From the Map options screen, tap .

2.	 The zoom buttons will be displayed on the Map screen in translucent mode.

Note: The zoom buttons will automatically disappear after the map is idled for 5 seconds.
3.	 Complete the following:

If you want to… Then…

zoom in the map, tap and hold .

zoom out the map, tap and hold .
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Advanced routing functions
IQ Routes™

Your Mio features IQ Routes, which intelligently anticipates congested roads at peak times 
so that they can be avoided. IQ Routes does this by using historical, anomalised data from 
millions of fellow drivers. Since IQ Routes helps you automatically avoid predicted heavy 
congestion, you will be able to save time and money during your journeys. 

LearnMe Pro™

With LearnMe Pro technology, your Mio includes an intelligent capability that learns and 
adapts to your personal driving style. Over time, your Mio learns your preferences for road 
types and driving speeds, turns and more. Your Mio will save the information and provide 
a more personalised route and accurate time of arrival the next time you plan a trip.
Note: For more information on IQ Routes and LearnMe Pro settings, refer to "Route options" in the 
“Customising the system settings” section.
Back-On-Track™ automatic rerouting

You will be redirected if you make a wrong turn. A message informing you that your route 
is being recalculated will display at the top of the screen.

To cancel a route re-calculation, tap  from the Map options screen. A warning will 
display asking you to confirm the cancellation. If confirmed, both the re-calculation and 
your current route will be cancelled.

Parking assistant

You will be reminded of the parking information when you are arriving at the destination 
(within 1 km) of the route. Simply tap the  icon on the Map screen to show the nearby 
parking lots that are sorted by distance.

How do I create a trip with multiple stops?
You will be able to set multiple stops or waypoints for your trip. Your route will be 
calculated to go via each of these points in the specified order.

1.	 On the Main Menu, tap .

2.	 Tap Create New Trip. 

  
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3.	 Tap Add. Use the FIND address wizard, Explore map, My Places/Recent Locations 
menu or Here/Return to start to set the waypoint.

4.	 When your search is done, tap .

  

5.	 Complete the following:

If you want to… Then…

add another waypoint, tap Add. 
Note: Waypoints added after a multi-stop trip has 
commenced will not be included in the current route.

navigate to your selected destination, tap .

edit the trip, tap Edit, then you can:

�� optimise your trip by selecting Optimise.

�� change the trip title by selecting Rename.

�� delete the planned trip by selecting Delete.

Note: The Optimise function does not take all factors into account. Your waypoints might be 
reordered to reduce your estimated travel distance. Be sure to confirm the trip on the map and 
make adjustments as appropriate, particularly if your trip returns to the start location.

How do I edit the waypoints in the trip?

1.	 On the Main Menu, tap .

2.	 Tap the trip to edit.

3.	 Tap the desired waypoint in the trip.

  

4.	 Complete the following:
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If you want to… Then…

delete a waypoint, tap Delete, then select OK.

change the order of the waypoint, tap  or .

How do I skip a waypoint during a multi-stop trip?
1.	 Tap anywhere on the Map screen to bring up the Map options screen.

2.	 Tap , then select Yes. The next waypoint will be skipped and the route recalculated 
to the following waypoint.

Note: You can also add waypoints during the trip by selecting  from the Map options screen.

How do I capture a location or a journey?
Your Mio has a capture feature which allows you to record GPS co-ordinates of a location, 
and capture a journey and save them so you can navigate back at a later time.

How do I capture the GPS co-ordinates of my location?

1.	 On the Main Menu, tap .

2.	 Tap Save, or wait for 5 seconds. You will hear a shutter sound to indicate that the GPS 
co-ordinates have been saved. The location is saved in My Places.

Note: Tapping Save as Car will save the current car location in My Places.

How do I capture a journey?
To enable capturing of journeys, you must first enable Capture Journey from the Main 

Menu >  > Route options. For more information, refer to the “Customising the 
system settings” section.

1.	 At the beginning of the journey you would like to record, tap Clear. All travel that 
you have made (i) since midnight, (ii) the previous time you tapped Clear, or (iii) last 
captured a journey, will be deleted.

2.	 Travel on your journey. Your Mio will keep a record of where you travel.

3.	 At the end of your journey, tap  on the Main Menu.



27

4.	 On the Capture screen, tap .

5.	 Tap Save, then Yes. The journey is saved in My Places.

How do I navigate to a location I have captured?

1.	 On the Main Menu, tap .

2.	 Tap the captured destination you want to travel to ( ). 

3.	 Tap . Your Mio will calculate the route from your current location. 

How do I navigate to the saved car location?

1.	 On the Main Menu, tap .

2.	 Tap Find My Car. 

3.	 Tap . Your Mio will calculate the route from your current location. 

How do I view a journey I have captured?

1.	 On the Main Menu, tap .

2.	 Tap the captured journey you want to view ( ).

My Places
My Places has all your saved locations.

How do I save a location as My Place or Home?
1.	 Search for an address until the Preview screen is displayed.
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2.	 Tap . The location will be added to My Places.

3.	 To save the location as Home, tap . Tap . The location has been set as Home.

How do I navigate to a location I have saved?

1.	 On the Main Menu, tap .

2.	 Tap the Sort by button to change the sorting order of the items:

: by time      : by name      : by type

3.	 Tap the favourite destination you want to travel to. 

4.	 Tap . Your Mio will calculate the route from your current location. 

How do I navigate to Home?
If you have not set an address as Home, the first time you try to navigate to Home you 
will be prompted to search for an address using the address-entry wizard.

1.	 On the Main Menu, tap .

2.	 Tap .

3.	 Tap . Your Mio will calculate the route from your current location. 

Once your home has been set on your Mio, simply tap  on the Main Menu and you 
will be directed to Home quickly.
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How do I navigate to a recent place?
To make navigating to an address easier, your Mio will automatically save all your start 
locations and destinations in a list of recent places.

1.	 On the Main Menu, tap .

2.	 Tap .

3.	 Tap a recent place. 

4.	 Tap . Your Mio will calculate the route from your current location. 

How do I edit a saved location in My Places?

1.	 On the Main Menu, tap .

2.	 Select a location to edit. 

3.	 Tap .

4.	 Complete the following:

If you want to… Then…

save the location as Home, tap .

rename the location, tap . After you have edited the name, tap OK.

delete the location, tap .

How do I navigate to a NavPix™?
NavPix™ is an image or picture, normally of a location, which contains embedded GPS 
co-ordinates that you can navigate to. 

To navigate to a NavPix™ location, either a GPS fix must have been available when the 
NavPix™ was taken, or GPS co-ordinates have been added using MioMore Desktop.
Note: For more information on importing the NavPix™ to your Mio, refer to the "Photo Album" 
section in “What is MioMore Desktop?”

1.	 On the Main Menu, tap .

2.	 Tap NavPix.
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3.	 From the list select the album ( ) you want. The album contains your pictures and 
displays them as thumbnails.

  

�� : Indicates that the picture is a NavPix™, with embedded GPS co-ordinates.

�� Slide Show: Displays all images in the album as a full-screen slideshow.

4.	 Tap the desired thumbnail to open the NavPix™ in full screen.

Icon Description

/ Tap to start/stop slide show.

Tap to display the Navpix Details screen.

Tap to calculate the route, open the Map screen and start navigating.

/ Tap to scroll through your NavPix.

How do I edit the NavPix™?
1.	 From the Album screen, tap the desired thumbnail to open the NavPix™ in full 

screen.

2.	 Tap .
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3.	 Complete the following:

If you want to… Then…

calculate the route and start 
navigating,

tap .

edit the NavPix™, tap .

�� To save the location as Home, tap .

�� To rename the title of the NavPix™, tap .

�� To delete the NavPix™, tap .

explore the map, tap .

How do I search for a POI?
A POI (Point of Interest) is a named site, feature, landmark or public venue which can be 
displayed as an icon on the map. POIs are grouped by category, such as petrol stations, 
parks, beaches and museums.

How do I find the nearest POIs using Near Me?
Near Me services allow you to quickly search the local area for common types of 
important POIs.

�� : Search for the nearest restaurants, cafes, fast-food premises and other dining 
establishments.

�� : Search for the nearest petrol stations.

�� : Search for the nearest parking places.

�� : Search for the nearest hotels and motels.

�� : Search for the nearest banks and ATMs.

�� : Search for the nearest emergency services, including hospitals and police 
stations.

�� : Customise the categories for search.

1.	 On the Main Menu, tap .

2.	 Select the desired POI category.
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  

3.	 Tap  or  to scroll up or down the result list. 

4.	 Select the desired item to display the destination screen.

5.	 Complete the following:

If you want to… Then…

calculate the route and start 
navigating,

tap .

save the location as a favourite, tap . The location will be saved in My Places 
immediately.

explore the map, tap .

How do I customise the categories for search?

1.	 On the Main Menu, tap .

2.	 Tap .

3.	 Complete the following:

If you want to… Then…

add the categories by POI type, tap POI type. Select the desired category for search.

add the categories by keywords, tap Keywords. Enter the keyword of the category for 
search.

4.	 To delete the added categories, tap . Select the category to remove and then tap 
Delete.

How do I find the POIs using Explore?
You can search for the POIs using the Explore map. The Explore map allows you to explore 
the local area to find Points of Interest (POIs) or navigate to an address. If you do not have 
a GPS fix, the map will display your last known position.

1.	 On the Main Menu, tap .

2.	 On the Explore map, you can:
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�� View the information of the selected POI that is shown at the top of the screen.

�� Tap and drag the map to explore your desired local area.

�� Tap and drag the map to display a POI Cluster showing POIs in the surrounding 
area. Tap a POI icon to show more information and navigate to the POI.










Item Description

 Tap to return to the previous screen.

 Information area Display the information of the selected POI/position.

 POI cluster Tap an icon or street name in the POI cluster to view 
information and options.

 Current position Your current position is marked with . 

 Tap to set POI preferences.

  / To zoom in or out, tap and hold  or . Zooming in or out 
will decrease or increase the area contained within the Explore 
area.

How do I find a POI using the POI cluster?
Tapping on the selected POI will bring up the screen with the POI destination details.

   
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  

Complete the following:

If you want to… Then…

calculate the route and start 
navigating,

tap .

save the location as a favourite, tap . The location will be saved in My Places 
immediately.

explore the map, tap .

How do I set my POI preferences?
POIs are grouped into categories. You may choose to either display (or hide) icons of all 
POI categories on the Map screen, or only display the icons from selected categories.

1.	 Tap .

2.	 Complete the following:

If you want to… Then…

display all POI icons, tap Show all.

display no POI icons, tap Hide all. 
Note: Hiding POIs will stop you from finding them when 
using explore mode/cluster search.

select a specific POI icon for display, tap the required POI category to show ( ) or hide 
( ) on the Map screen. 

Repeat until all required categories are selected.
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If you want to… Then…

return to the Explore map, tap .

Note: Your preferences are automatically saved.

How do I search for a POI by type?

1.	 On the Main Menu, tap .

2.	 Tap .

3.	 Complete the following:

If you want to… Then…

search for the POIs near your current 
location,

tap . 

search for the POIs in a specified city 
or area,

tap . After you have entered a name of a city/

area, tap OK.

search for the POIs on your route, tap .

search for the POIs near your 
destination,

tap .

4.	 Complete the following:

If you want to… Then…

search for POIs by keyword, tap . After you have entered a keyword, tap 
OK.

search for restaurants, cafes, fast-
food premises and other dining 
establishments,

tap .

search for petrol stations, tap . 

search for parking places, tap .

view more POI types, tap . Select a POI type. 

search for hotels and motels, tap . 

search for banks and ATMs, tap . 

search for emergency services, tap . 

5.	 Tap the desired item from the list.
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6.	 Complete the following:

If you want to… Then…

calculate the route and start 
navigating,

tap .

save the location as a favourite,
tap . The location will be saved in My Places 
immediately.

explore the map,
tap .

How do I search for a POI by keyword?
Complete the following to navigate to a POI or the street address that you find by 
keyword.

1.	 On the Main Menu, tap .

2.	 Tap . Enter the keyword of the POI or Street Address that you want to search.

3.	 Complete the following:

If you want to… Then…

calculate the route and start 
navigating,

tap .

save the location as a favourite,
tap . The location will be saved in My Places 
immediately.

explore the map,
tap .
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Recording your driving
Precautions and notices

�� Make sure that no object is blocking the camera lens and no reflective material 
appears near the lens. Please keep the lens clean.

�� If the car’s windscreen is tinted with a coating, it may impact the recording quality.

�� Minor accidents may not trigger automatic recording.

�� To ensure the optimal recording angle, pay attention to the following:

�� Make sure that your car is parked on a level ground.

�� When adjusting the angle of mounting, make sure that the camera’s view is parallel 
with the level ground, and the ground:sky ratio is close to 6:4.

�� To make sure of the correct date and time for your recordings, please make sure that 
the device has already gotten a GPS fix before you begin recording. The current date 
and time displays at the bottom of the recording screen.

Memory card for recording
Make sure that the recording-specific MicroSD card (a Class 4 memory card with a 
4GB~32GB capacity) has been inserted into the memory card slot for recording on the 
top of the device.

When you use a new MicroSD card for recording for the first time, format the card on the 
device to make it recording-specific.

1.	 Tap  on the Main Menu or the Map screen.

2.	 Tap anywhere on the screen and tap .

3.	 Tap Card Format > Execute.

Making a recording
Recordings are made in Camera mode ( ).

A recording can be triggered when:

�� an AC power source is connected to the device that has been turned on.

�� an event happens (such as sudden impact, high-speed driving, an overdone turn 
or an accidental crash) for the G sensor to prompt the device to start recording 
automatically.

�� you tap  on the Main Menu or the Map screen.
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The recording proceeds in a continuous mode and is divided into several temporary video 
clips (segments). The recording will not stop between video clips. If continuous recording 
is ongoing but there is not enough space on your memory card, new video clips will 
replace the old ones.

The  icon at the bottom of the screen indicates the recording mode, and the recording 
length (for example, 00:00:08) shows on the upper-right corner.

You can tap  /  to zoom in/out the image.

To return to the Main Menu or the Map screen without stopping the recording, tap 
anywhere on the screen and then tap . The recording will still continue in the 
background until you stop it.

To stop or restart the continuous recording, tap anywhere on the screen and then tap .

Note: When an AC power source is disconnected from the device, the recording will automatically 
stop.

Photo mode

You can take a photo by tapping anywhere on the screen and then tap  > .

You can tap  /  to zoom in/out the image.

Playback mode
To switch to the playback mode, tap anywhere on the screen and then tap . The 
screen displays the latest recording.

�� Tap  to start/pause the playback.

�� Tap  /  to switch to the previous/next recording.

�� Tap  /  to adjust the volume level.

�� Tap  to delete the current recording.

Customising the settings

�� In Camera/Photo mode, tap anywhere on the screen and then tap  to access the 
camera/photo settings.

�� To access the dash cam settings, tap anywhere on the screen and then tap .

To exit the settings, tap .
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Category Item Description

Camera Resolution Sets the image resolution.

Quality Sets the video quality.

White Balance Sets the white balance setting according to the 
current lighting environment.

Stamp Sets how you want to show the information in 
the recordings.

Photo Resolution Sets the image resolution.

Quality Sets the photo quality.

EV Sets the exposure level to adjust the brightness 
of the image. 

White Balance Sets the white balance setting according to the 
current lighting environment.

ISO Sets the ISO level.

Colour Sets the colour mode.

System Settings Card Format Formats a MicroSD card for recording-specific 
purposes. (All data will be erased.)

System Reset Restores system settings to factory defaults.

Flicker Freq. Sets the frequency to match the flicker frequency 
of the local power supply when recording.

Video System Sets the video ouput system.

Version Displays the software information.
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Customising the system settings
1.	 On the Main Menu, tap .

2.	 Select the option you want to customise from the Settings screen. 

3.	 Once you change the settings and return to the previous screen, your preferences are 
automatically saved.

While changing the settings, the check box next to the option indicates the setting status:
�� : on/enabled

�� : off/disabled

Audio

If you want to… Then…

increase/decrease the volume, tap  / .

You can simply tap on the volume bar so that the 
volume will be set immediately at the position 
you tapped. The Volume bar indicates the current 
volume level.

mute/unmute, tap .

The speaker icon indicates the status:

: muted     : unmuted

hear which letter you have tapped when you 
tap the touch screen,

tap Touch audio to turn it on or off.

Screen

If you want to… Then…

change the displayed screen 
mode,

tap Screen mode and select:

�� Auto: set to automatically change between Day and Night 
modes.

�� Day: set the screen to be displayed in Day mode.

�� Night: set the screen to be displayed in Night mode.

change the screen brightness in 
Day/Night mode,

tap  /  on the day brightness/night brightness bar.

The brightness bar indicates the brightness level.

You can simply tap on the brightness bar so that the screen 
brightness will be set immediately at the position you tapped.
Note: Your Mio can heat up when the brightness scale is set high, 
therefore, use lower brightness whenever acceptable.

Safety
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If you want to… Then…

enable/disable the warning message 
after long-distance driving,

tap Driver fatigue alert to turn it on or off.

enable/disable speed limit alerts, 
which warn you of the speed limit 
on any given road,

�� tap Speed limit display to turn it on or off.

�� Tap Speed limit alerts and select:

○○ Off: disable the speed limit alert.

○○ Auto: set the system to alert automatically while 
your speed is above the limit.

○○ Speed limit + 5 km/h (+ 3 mph): set the system to 
alert while your speed is 5 km/h (3 mph) or more 
above the limit.

○○ Speed limit + 10 km/h (+ 7 mph): set the system to 
alert while your speed is 10 km/h (7 mph) or more 
above the limit.

set the speed limit alerts manually, tap Set manual speed alert to select the speed limit or turn 
it off.

enable/disable a visual warning if 
the screen is accessed in a moving 
vehicle,

tap Warn me not to operate my Mio while driving to turn 
it on or off.

set how you want to receive the 
camera and safety alerts,

tap Safety Camera / Mobile Safety Camera / Average 
Safety Camera / Red Light Camera / Dangerous zones to 
select:

�� No alerts

�� Visual alert

�� Visual & Audible alerts

Route options

If you want to… Then…

change the navigating mode, tap Mode to select Car or Truck.
set route type options for your 
route,

tap Route type to select your route type preference from 
the list:

�� Fastest: The route that should be the fastest when 
navigating.

�� Easiest: The simplest route with the least number of 
turns and favours motorways where appropriate.

�� Economical: The route with least number of stops, turns 
and urban areas which should save on fuel usage.

�� Shortest: The route with the shortest physical length.
set types of road options for your 
route,

tap Types of road. Select your road preference from the list.
Note: Avoiding ferry routes may prevent you from navigating 
between certain countries, even when a bridge or tunnel exists.
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If you want to… Then…

set the routing preferences, tap Advanced routing to turn the IQ Routes / LearnMe Pro 
functions on or off.

�� Use historic traffic speed date: enable/disable the IQ 
Routes function.

�� Use learned driver behaviour: enable/disable the 
LearnMe Pro function.

�� Driving speed records: display the information of your 
driving speed on a motorway / highway / major road / 
minor road.

set the avoidance manually, tap Custom Avoidance.

�� Tap Add Avoid Road and then follow the on screen 
instructions to select the avoid road from the map view 
screen. 

�� Tap Add Avoid Area and then follow the on screen 
instructions to select the avoid area from the map view 
screen.

Note: Once the avoidance has been set, it will not be added to your 
route while you are planning the trip.

Note: To edit the assigned avoidance, tap the item from the Custom 
Avoidance screen and then select Enabled/Disabled, Rename, or 
Delete.

display the installed custom POI, tap Custom POI alerts.
display the landmarks on your 
route,

tap Landmark guidance to turn it on. 

record mileage for your route to 
generate expense reports,

tap Mileage recorder to turn it on. 

record your journey, tap Capture Journey to turn it on. 

Map display

If you want to… Then…

enable/disable automatic zooming 
during navigation,

tap Auto-zoom map when navigating to turn it on or off. 

When selected, the Map screen will automatically zoom in 
or out, depending on your speed, to allow optimal viewing of 
your route.

display “no entry” icons on “no 
entry” roads on the Map screen,

tap Show no-entry road signs to turn it on. 

When turned on, the map display performance can slow 
down due to the number of no entry roads in some major 
cities.

set your map screen preference, tap Map to select between a 3D or 2D view of the Map 
screen.

change the map colour scheme, tap Map scheme, then select a colour scheme from the list.
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My Maps

If you want to… Then…

view the map information, tap Map version to display a list of all maps and the detailed 
information.

select a set of maps to load, tap Map set, then select your preference from the list.
check the expiring maps, tap Expiring maps to display a list of maps that are to expire 

soon.

Language

If you want to… Then…

change the on-screen language, tap Language and select your preferred language from the 
list.

change the voice scheme, tap Voice and select your preferred voice scheme from the 
list.

Units

If you want to… Then…

change the distance units, tap Distance units and then select your preferred distance 
unit type.

change the time format, tap Time format and then select your preferred time format.
change the date format, tap Date format and then select your preferred date format 

type.

Time Zone

If you want to… Then…

set the time zone automatically, select Auto time zone.
change the time zone manually, select Manual time zone, then adjust the setting by tapping 

 / .

Trip Meter

The Trip Meter option displays the information of your trips.
�� : display the current trip

�� : display all trips
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Device

If you want to… Then…

delete the saved information on 
your Mio,

tap Delete saved information:

�� Tap Delete My Places and tap Yes when the warning 
dialog box displays. The data saved in My Places will be 
deleted.

�� Tap Delete recent locations and tap Yes when the 
warning dialog box displays. The data of recent locations 
will be deleted.

�� Tap Delete planned trips and tap Yes when the warning 
dialog box displays. The planned trips saved on your Mio 
will be deleted.

restore factory default settings, tap Restore factory defaults. When the warning dialog box 
displays, tap Yes. Your Mio will restart.

The Restore factory defaults option allows you to restore 
default factory settings but will not delete recent locations 
or saved My Places destinations.

reset the GPS, tap Reset GPS. When the warning dialog box displays, tap 
Yes.
Note: Occasionally, the GPS fix may need to be reset. This may 
occur if the receiver has been transported a long distance since last 
being used; for example, to a different country, and is still trying to 
establish the previous position.

record a GPS log of your trip, tap GPS logging to turn it on.

Demo

If you want to… Then…

enable a shop demonstration of Mio 
Spirit to be played,

select a demonstration country from the list and tap Start. 
Tap OK. Your Mio will restart.

When your Mio is in Shop demo mode, you will see the 
navigation demonstration of the pre-defined route without 
having to set a destination.
Note: You cannot operate your Mio properly in Shop demo mode.

Help

If you want to… Then…

view the tutorial, tap View Tutorial.

To display the tutorial on each start-up, select the Show 
tutorial on start-up option on the initial screen of tutorial.

view copyright and trademark 
information,

tap About.
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What is MioMore Desktop?
MioMore Desktop is a suite of tools you can use to access greater functionality and 
product information via your computer.

MioMore Desktop allows you to:

�� obtain software updates
�� manage maps
�� manage custom POIs
�� plan trips
�� manage safety camera subscriptions

Can I use MioMore Desktop with my computer?

Ensure your computer has the following minimum system requirements before installing 
MioMore Desktop:

�� IBM compatible PC
�� Microsoft Windows Vista, Windows 7 or Windows 8
�� Internet Explorer 6 or later versions
�� DVD drive
�� USB port
�� Internet connection for activation

Note: Microsoft .NET 2.0, 3.0 and 3.5 will be installed on your computer as part of the installation 
of MioMore Desktop.

How do I install MioMore Desktop onto my 
computer?
1.	 Close all programs on your computer.

2.	 Insert the MioMore Desktop Application Installer DVD into your computer DVD drive. 
The MioMore Desktop installer will start.

If your computer does not automatically launch the DVD, start the installation 
manually: Start > Run. Type D:\Install.exe where “D” is the letter assigned to your 
DVD drive, then click OK.

3.	 Select your preferred language.

4.	 Click Install Software, then Install MioMore Desktop.

5.	 Follow the on-screen prompts to install MioMore Desktop:

6.	 Connet your Mio to your computer when prompted.

7.	 Turn on your Mio, and then select the Computer option from the pop-up message 
screen.
Note: If prompted to update your Mio software, follow the on-screen prompts.



46

8.	 You are now ready to use MioMore Desktop for your Mio. 

From now on, you can access MioMore Desktop via: Start > All Programs > Mio > 
MioMore Desktop.

My Subscriptions
Your Mio contains pre-loaded subscriptions, such as safety camera and travel book 
information. For the latest subscription updates, visit: www.mio.com 
Note: Safety camera alerts can be enabled to provide warnings when on your route.

How do I purchase a subscription?
1.	 Open MioMore Desktop, and then click My Subscriptions.

1.	 Select a type of subscription.

2.	 Select a region.

3.	 Select a subscription or offer, then click Purchase an activation key from the Mio 
store.

4.	 Follow the prompts to purchase your subscription.

A product key will be sent to you via email when you have subscribed. You will need to 
use this product key to activate your subscription.

How do I activate my subscription?
1.	 Open MioMore Desktop, and then click Unlock Features.

2.	 Enter your product key.

3.	 Follow the prompts to activate your subscription.
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How do I update subscriptions on my Mio?
The My Subscriptions section will display a list of subscriptions already installed on your 
Mio:

Icon Description

Red Expired subscriptions.

Right click to purchase a new subscription.
Yellow Available subscriptions.

Right click to update and purchase new subscription.
Green Active subscriptions.

No updates are available for these subscriptions.

How do I recover my subscription?
If your subscriptions are deleted and you want to recover them, click Recover 
Subscriptions at the bottom-right corner in My Subscriptions to recover all subscriptions.

My Maps
My Maps allows you to install new maps, remove maps from your Mio and purchase new 
maps.
Note: The downloaded/purchased map (*.iso) from Mio website will be saved on your computer’s 
map folder (e.g. C:\username\Documents\Maps) and then displayed in My Maps. The default map 
folder may vary depending on your operating system.
Open MioMore Desktop, and then click My Maps.

 



Item Description

 Loadable Maps A list of maps on the DVD or available for purchase via the Mio 
Store website.
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Item Description

 My Mio A list of maps installed on your Mio.

 Remove Maps Click to remove the selected map from your Mio.

How do I download a map update?
Occasionally Mio may offer you free updates, including software applications, maps, and 
more. If a free map update is available and your Mio is connected to your computer, a 
message will display when you first start MioMore Desktop.

1.	 From the pop-up message window, click View to display the Device Updates screen 
that contains the available updates.

2.	 Before downloading, you can change the download folder by clicking Change Path.

3.	 Select the desired map update and click Download. MioMore Desktop will start to 
download immediately.

4.	 During the download operation, you can:

�� Stop the download by clicking .

�� Pause the download by clicking , and then resume download at a later time by 
clicking .

5.	 When finished, the downloaded map update will be displayed in My Maps.

How do I install maps onto my Mio?
Your Mio comes with one or more pre-activated maps. Map files take up space on your 
Mio’s internal memory. If you do not use a map file, you can remove it to free up space. 
You can later reinstall it to your Mio if required.

You can install maps from the following:

�� The DVD that came with your Mio

�� The downloaded map update

�� The map that you have purchased separately on a memory card or your Mio internal 
memory.

Note: You may need to purchase a Map Product Key to activate maps on the DVD that came with 
your Mio.
1.	 Open MioMore Desktop, and then click My Maps.

2.	 Select a map source and then click Open to display the Map Source section.

�� The maps already installed on your Mio are green.

�� The maps that are unlocked and ready to be installed to your Mio are yellow.

�� The maps that require activation before being installed to your Mio are red.

�� The maps that are available for purchase from Mio are blue.
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Note: If your computer opens Windows Explorer when the DVD is inserted, close the Windows 
Explorer window.

3.	 Complete the following:

If the map to be 
installed is…

Then…

yellow go to step 6.
red the map needs to be activated via the Internet before it can be 

installed; continue to step 4.

4.	 If you connect to the Internet via a dial-up connection, connect to the Internet now.

5.	 Follow the prompts to activate your Map Product Key, including:

�� Enter the Map Product Key when prompted.

�� Your computer will connect to the Internet and activate your Map Product Key.

�� When activation has completed, the map will change colour to yellow; continue to 
step 6.

6.	 Click the map you want to install to your Mio. The map will change colour to a brighter 
yellow to indicate it has been selected. To deselect a map, click the map again.

You may need to install multiple maps to cover the required geographical area.

7.	 Complete the following:

If you want to… Then…

install a yellow map, go back to step 6.
install a red map, the map needs to be activated via the Internet 

before it can be installed; go back to step 4.
install the selected maps to your Mio, continue to step 8.

8.	 Select the destination media (Mio internal memory) for the selected maps, then click 
Install Maps.

The selected maps will be installed and change colour to green.

Do not disconnect the USB cable from the Mio USB Socket until the installed map or 
maps have changed colour to green.

9.	 To use your Mio, disconnect the USB cable. You may need to manually reset your Mio.

How do I remove maps from my Mio?
1.	 Open MioMore Desktop, and then click My Maps.

2.	 From the My Mio panel, select the check box next to the map you want to remove.

3.	 Click Remove Maps to remove the selected maps.

4.	 Confirm that you want to remove the selected map when prompted. The map is 
removed from your Mio. You can reinstall these maps at any time via MioMore 
Desktop.
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Custom POIs
The Custom POIs (Points of Interest) application allows you to create or import your own 
POI files. These are called custom POIs. Unlike preinstalled POIs, custom POIs can be 
removed from your Mio and can have audio as well as visual alerts associated with them.

To create your POI files, open Microsoft Excel and then enter the POI location details 
(including lngitude, latitude, name, and description) in separate cells. Always use decimal 
degrees for coordinates and start a new location from a new line. When done, click File 
> Save As to save it as a *.csv file. Now you have successfully created a POI CSV file. The 
following displays the example of creating the POI file by using Microsoft Excel:

Note: Various POI files are available for download free or by subscription from third-party websites. 
Ensure that downloaded files are in .csv (Comma Separated Values) format. Mio is not responsible 
for the content or accuracy of the information or the reliability or availability of these websites. The 
use of information regarding safety camera locations may be subject to local laws in the country 
of use. You are responsible for checking that you can use the information in your country or in the 
country where the information will be used.

How do I install custom Points of Interest?
1.	 Open MioMore Desktop, and then click Custom POIs.

2.	 In the Add new POIs section, click Browse to select a source file.

3.	 Select the file from your local or network drive, then click Open.

4.	 From the POI Category section:
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If you want to… Then…

use an existing custom POI category, select Existing category, then select a type from the 
drop down list.

replace an existing POI, select Existing category and a type from the drop-
down list, then select Replace existing POIs. 
Note: If you want to create a new POI instead, then select 
Add to existing POIs.

create a new custom POI category, select New category, then type a name for the POI 
category.

5.	 Set alert settings as required:

If you want to… Then…

enable a visual warning when a POI of 
this category is in close proximity,

select the Visual alert check box.

select an icon to display on the Map 
screen for POIs of this category,

click Browse to select the icon file from your local or 
network drive.

When you have located the icon file, select it and click 
Open.
Note: The icon file must be a bitmap (*.bmp or *.png) graphic 
with a minimum size of 6x6 pixels and a maximum size of 
32x32 pixels.

Note: If you do not select a custom icon, a default icon will 
display.

select the distance from a POI of this 
category at which the visual warning 
should display or the warning chime 
should sound,

select the distance from the Distance box.
Note: To change the units used to measure distance for this 
POI category, from the tools menu click on options and from 
the general option select Use metric units check box.

enable a warning sound when a POI of 
this category is in close proximity,

select the Audio alert check box.

select a custom sound alert file to 
play when a POI of this category is in 
close proximity,

�� either select a sound file from the list, or 

�� Click Add to select a sound file (.WAV format) from 
your local or network drive. When you have located 
the file, select it and click Open.

Note: If you do not select a custom sound file, a default 
sound alert will play.

6.	 Click Add to device to add the POI to your Mio.
Note: Each file corresponds to a POI category; for example, Hotels.csv will be listed on your Mio as 
the Hotels category.

How do I delete a Custom POI file/category from my Mio?
1.	 In the Installed POIs section, click Delete next to the file name. The file is removed 

from the list, but is not yet deleted.

2.	 Accept the warning message. The selected file/category is deleted.
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Photo Album
Photo Album is a MioMore Desktop application which allows you to copy, delete or move 
pictures or albums between the NavPix™ library on your Mio and the NavPix™ 
library on your computer.

Open MioMore Desktop, and then click Photo Album.
Note: Depending on your Mio model, certain Photo Album features may not be available.













Item Description

 Desktop albums Displays a list of all albums stored in the NavPix™ library on 
your computer.

�� Click an album to display its contents in the Album display 
area.

�� Click View all NavPix to display all pictures stored in the 
NavPix™ library on your computer.

 My Mio albums Displays a list of albums stored on the Mio internal memory 
and on the memory card if one is inserted.

�� Click an album to display its contents in the Album display 
area.

 Selected picture When a thumbnail is selected, it displays with a blue border.

 Album display area Displays thumbnails of pictures in the selected album.

 Search Type to search for a NavPix™ by name.

 Toolbar When a picture is selected, the icons which can be used will be 
active.
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Toobar

        

Item Description

 Create new album Click to create a new album in the NavPix™ library you are 
viewing.

 Add to My Places Click to transfer NavPix™ to My Places.

 Transfer to your Mio / 
Transfer to your computer

�� If you are viewing NavPix™ in the NavPix™ library on 
your computer, this will display as Transfer to your Mio. 

Click to transfer the selected NavPix™ to your Mio.

�� If you are viewing NavPix™ in the Mio library this will 
display as Transfer to your computer. 

Click to transfer the selected photo(s) to the NavPix™ 
library on your computer.

 Import NavPix™ Imports NavPix™ from your computer to the NavPix™ 
library on your computer.

 Export to disk Click to save NavPix™ to your computer or a network drive.

 View details Click to view the selected NavPix™ and edit NavPix™ 
details, including:

�� NavPix™ name

�� latitude

�� longitude

�� description

 Rotate left Rotates the selected NavPix™ 90° to the left.

 Rotate right Rotates the selected NavPix™ 90° to the right.

 Delete NavPix™ Click to delete the selected NavPix™.

What else can I do with pictures and albums on my 
computer?

If you want to… Then…

add a picture to another album, in the Desktop albums section, select the album 
containing the NavPix™ you want to include in 
another album.

Select the NavPix™ then drag it to the other album.
Note: The selected NavPix™ is included in the new album, 
but is not moved. One instance of the NavPix™ in the 
library may be included in multiple albums.
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If you want to… Then…

remove a picture from an album, in the Desktop albums section, select the album 
containing the NavPix™ you want to remove.

Right-click on the selected picture and select Remove 
from album.
Note: Click the Delete icon on the toolbar if you want to 
delete the NavPix™ from all albums.

add a NavPix™ to My Places, in the Desktop albums section, select the album 
containing the NavPix™ you want to add to My 
Places.

Right-click on the selected picture and select Add to 
My Places.

upload picture to the Flickr website, in the Desktop albums section, select the album 
containing the NavPix™ you want to upload to the 
Flickr website.

Right-click on the selected picture and select Upload 
to Flickr.
Note: You need a Flickr account to upload NavPix™. To 
create a Flickr account visit www.flickr.com.

export a NavPix™ to Google Earth™ in the Desktop albums section, select the album 
containing the picture you want to export to Google 
Earth.

Right-click on the selected picture and select Export 
to Google Earth.

Navigate to a folder on your computer to save the file 
and then open it in Google Earth.
Note: You need to install the Google Earth software on your 
computer to be able to view the file you have created. You 
can download Google Earth from earth.google.com.

search for other NavPix™, right-click on the desired NavPix™ and select 
Search for NavPix near this.

Photo Album preferences
Open MioMore Desktop, and then click MY MIO > Options > Photo Album.

Complete the following:

If you want to… Then…

change your NavPix™ location on your 
computer,

click Change and select a location for your NavPix™ 
library.

Click Save or OK. The warning message will display 
and you will be prompted to confirm your action.

receive a warning message before deleting 
an image from your device,

select the Warn me when permanently deleting a 
NavPix from my Mio check box.



55

If you want to… Then…

receive a warning message before deleting 
an image from your NavPix™ library,

select the Warn me when permanently deleting a 
NavPix from my library check box.

create a new folder every time you import 
new photos,

select the Import photos to a new album check box.

view NavPix™ when on a route, select the Show NavPix on map check box.

Image Search
Image Search is a MioMore Desktop application powered by Flickr™ allowing you to 
download photos and import them to Photo Album. You can then upload the photo to the 
Flickr website, transfer photos to your Mio, export pictures to Google Earth or search for 
other NavPix™ near the longitude and latitude of your NavPix™.

How do I search for NavPix™ on the Internet?
1.	 Open MioMore Desktop, and then click Image Search.

2.	 In the Description field enter a search description for the image you are looking for.

3.	 Select one of the Sort by options.

4.	 Click Search. Thumbnails of the NavPix™ will be displayed in the NavPix™ display 
area.

Note: You can narrow your search by selecting the Advanced search check box and then selecting a 
city from the drop-down list or by entering the latitude and longitude details.

How do I import NavPix™ to My Places?
1.	 Select a picture or group of pictures you want to add to your My Places.

2.	 Click Add to My Places.
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Unlock Features
If you have purchased a map unlock code or subscriptions for your Mio, you have to enter 
the activation key using the Unlock Features application.

Open MioMore Desktop, and then click Unlock Features.

Note: Make sure you have an active Internet connection for this feature.
Note: The activation key will be sent to you by email, or printed on the inside cover of the box if you 
purchase the map update DVD. You can click the link on the screen to purchase an activation key 
online.

Redeem
To redeem Mio’s lifetime map update service, you need to enter the product key using the 
Redeem application. Please note that the product key can only be used once and is not 
transferable.

Open MioMore Desktop, and then click Redeem.
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Note: Make sure you have an active Internet connection for this feature.
Note: The product key is printed on the flyer that is enclosed in the package.

My Places
My Places includes saved addresses, captured journeys and sound, POIs, NavPix™, and 
other locations. You can select, modify and delete places. You can also add locations from 
Connect and Image Search to My Places.

Open MioMore Desktop, and then click MY PLACES.

Note: Make sure you have an active Internet connection for this feature.
Note: You can install a maximum of 99 locations on your Mio via My Places. 



58

How do I sort My Place locations?
You can sort My Place locations by type and name:

If you want to… Then…

sort My Place locations by type, click Type on the My Places panel.
sort My Place locations by name, click Name on the My Places panel.

How do I import or export a location?
Complete the following:

If you want to… Then…

import a location from the computer to 
your Mio,

from the My Places panel, click Import.

Locate the file you want to import and then click 
Open.
Note: The supported file format for importing includes: *.KML 
and *.KMZ.

export a location from your Mio to the 
computer,

from the My Places panel, select a location and then 
click Export.

Enter a descriptive name for the file and then click 
Save.

Note: The supported file format for exporting includes: 
*.KMZ.

Note: You can also import/export a location by clicking File > Import (or Export) > My Places from 
the top of MioMore Desktop Menu.

How do I edit a location from the map screen?
1.	 From the My Places panel select the location you want to edit.

2.	 Click the location icon on the map.

3.	 Complete the following:

If you want to… Then…

edit the location name, click the location name.

Enter a new name or edit the existing name. The 
location name is changed in both MioMore Desktop 
and your Mio.

edit the location notes, click Edit notes.

Enter notes. The location notes are changed in both 
MioMore Desktop and your Mio.
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If you want to… Then…

share the location, click .

An email will open ready to send to your friends. 
Your friend will receive the email with links to either 
save the image or to save the location in My Places in 
MioMore Desktop.
Note: If the location is a NavPix™, your friend will receive 
the image as an attachment to the email.

Note: If the location is a captured journey, your friend will 
receive the journey as a *.KMZ file attached to the email. 
Your friend will need to have Google Earth installed on the 
computer to view the KMZ file.

delete the location, click , then click Yes to delete the location.

Note: You can delete all locations in My Places by clicking 
Delete on the My Places panel.

export the location, click .

Enter a descriptive name for the file and then click 
Save.

Trip Planner
Trip Planner in MioMore Desktop allows you to pre-plan your trip on the computer.

Open MioMore Desktop, and then click Trip Planner.

 

Item Description

 Route planner Plan a route by entering the From point and To point. A list of 
planned routes will display in the Pre-Planned Routes section.
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Item Description

 Display area Display the route on the map.

You can also plan your route directly on the map.

How do I pre-plan a route by search?
1.	 From the Route planner panel, set your From and To points.

You can find a location by:

�� : Keyword

�� : Address

�� : Postcode

Enter your text for search and click  to start a search. You may need to select 
from a category list to narrow your search results.

2.	 Complete the following:

If you want to… Then…

add a waypoint, click Add Waypoint.
reset or remove a waypoint, click  next to the waypoint.
set the route preferences, click Route option and select:

�� Mode: Select the desired mode to plan your route.

�� Type of route: Select the Fastest, Shortest, Easiest, 
or Economical way to plan your route.

�� Avoidance: Avoid Unsurfaced roads, Toll roads, 
Ferry routes, or Special zone in your route.

Note: The Route option settings will only apply to the route 
you are editing.

arrange the destinations in the most 
efficient order while two or more 
waypoints are included in the planned 
trip,

click Waypoint Optimization.

3.	 Click Plan Route to calculate your route. The route will be displayed on the map.

4.	 Click Save this route. The route is saved to the Pre-planned Routes section and your 
Mio simultaneously.

How do I pre-plan a route using the map?

1.	 From the map displayed in the display area, click .

2.	 The cursor will be marked with “Add route.” Move the cursor and then click on the 
map to set the From point.

3.	 The cursor will be marked with “Click to set destination.” You can:
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�� Move the cursor and then click on the map to set the waypoint.

�� Move the cursor and then double-click on the map to set the To point.

4.	 When done, click Save this route. The route is saved to the Pre-Planned Routes 
section and your Mio simultaneously.

How do I edit a route?
1.	 From the Pre-Planned Routes section, select a route to edit.

2.	 Complete the following:

If you want to… Then…

rename the route, click the title of the route in the Name column, then 
enter a new name and press ENTER. Your changes are 
automatically saved.

delete a saved route, click  next to the route you want to remove.

My Mio
Open MioMore Desktop, and then click MY MIO.

How do I change the displayed language for MioMore 
Desktop?
1.	 Click Language.

2.	 Select your preferred language.

How do I install or remove a voice file for my Mio?
1.	 Click My Voices.

2.	 Complete the following:

If you want to… Then…

install a voice file, in the Available voice files section, select the voice file 
you would like to install. Click Install selected voices.

remove a voice file, in the Available voice files section, select the voice 
file you would like to remove. Click Remove selected 
voices.

Note: Voice files take up space on your Mio’s internal memory. If you do not use a voice file, you 
can remove it to free up space. You can later reinstall it to your Mio if required. The provided DVD of 
your Mio is needed while installing the voice file.

How do I report mileage?
Mileage Reporter is a MioMore Desktop feature that allows you to create expense reports 
(.csv format) based on the mileage and estimated fuel usage recorded by your Mio.
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







Item Description

 Timeframe Specifies the time for which the mileage report will be created. 

Select Show All to include all recorded mileage.

 Report panel Displays your trip log data.

 Fuel Select to include the amount of fuel (estimate) used for the 
mileage recorded. If selected, specify the number of miles 
travelled per gallon, or miles/kilometres travelled per litre.

 Report data buttons Import report data from your Mio, clear all report data from 
your Mio or export data to a report (.csv).

Note: To use the Mileage Reporter function of MioMore Desktop, the Mileage recorder option on 
your Mio must be enabled. For more information, refer to the Route options section in “Customising 
the system settings.”
Note: To change the Mileage Reporter preferences, click MY MIO > Options > Mileage Reporter.

How do I backup and restore my Mio?
You can save backups of data from your Mio, and later restore it if required.

1.	 Click Backup and Restore.

2.	 Complete the following:

If you want to… Then…

backup your Mio, click Create new backup.

Select the data you would like to backup, then click 
OK.

The backup will be saved to your computer. The 
backup will be listed on the Backup & Restore window.
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If you want to… Then…

restore a backup to your Mio, select the backup from the list that you would like to 
restore.

Click Restore, then click OK. 

The backup will be restored to your Mio.
delete a backup, select the backup from the list that you would like to 

delete.

Click Delete, then click OK. The backup will be 
deleted.

How do I recover maps and voice files for my Mio?
The Smart Recovery application allows you to recover all data to fix your Mio if a problem 
occurs during operation, including software, maps, voice files, and subscriptions.

1.	 Make sure you have an active Internet connection and the Installer DVD is inserted 
into your computer DVD drive.

2.	 Click Smart Recovery.

3.	 The available data will be displayed in the Maps and Voices fields. Select the desired 
data and click Recover to recover the data on your Mio.

How do I manually update my Mio?
Occasionally Mio may offer you free updates, including software applications, maps, and 
more. You can manually check the available updates via the Device Updates function.

1.	 Click Device Updates. The Device Updates screen that contains the available updates 
will display.
Note: You can also open the Device Updates screen by clicking the New Update button at the 
top-right corner of MioMore Desktop.

2.	 Complete the following:

If you want to… Then…

download the updates, select the available update from the list, and then lick 
Download.

stop/pause the download, during the download:

�� Click  to stop the download.

�� Click  to pause the download; when paused, 
click  to resume downloading.

change the download folder, click Change Path.

3.	 When completed, the downloaded file will be saved to the assigned folder.

�� For software update, the *.exe file will be launched automatically to install the 
update.
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�� For map update, the system will display the My Maps screen automatically to 
install the update.

How do I configure MioMore Desktop?
1.	 Click Options, and then select the desired setting options to configure.

2.	 Complete the following:

If you want to… Then…

keep MioMore Desktop updated, click General, and then select the Auto check for 
updates check box.

When you select this option, every time you open 
MioMore Desktop, the available service packs and 
bug fixes will be downloaded from the Mio server and 
applied to your Mio.

change the units of measurement that 
MioMore Desktop uses,

click General, and then:

Select or clear the Use metric units check box to 
change between imperial and metric units.

Select or clear the Use decimal degrees check box 
to change between decimal degrees and latitude/
longitude co-ordinates.

change the Mileage Reporter settings, click Mileage Reporter, and then:

Select or clear the Warn me when deleting all log 
files from my Mio check box.

Select the Distance per volume or Volume per 
distance to change the fuel economy style.

change the NavPix™ library 
location,

click Photo Album, and then click Change.

change the location of where 
downloaded updates will be saved,

click My Maps, and then click Change.

Select a folder for the updates. The downloaded 
updates are moved to the new location.
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MiVue Manager
MiVue ManagerTM is a tool for you to view the videos recorded on a MiVue recorder.

IMPORTANT! Your computer needs MOV and AVI codecs to play the recording files. 
Search online to install the required codecs.
Note: Not all features are available for every model.

Installing MiVue Manager
1.	 Insert the supplied DVD into your computer’s DVD drive.

2.	 Double-click Setup.exe in the MiVue Manager folder.

3.	 Follow the on-screen prompts to install MiVue Manager.
Note: For Mac users: You need to install a free video codec package before playing the .AVI files.
	 For Mac OS X 10.7/10.8: 

Download and install Perian_1.2.3.dmg from http://www.perian.org/.
	 For Mac OS X 10.9: 

Download and install Perian_1.2.3.dmg from http://www.perian.org/. Quick Time 7 is also 
required.

Playing the recording files
Note: You are advised to copy the recording files to your computer for backup and playback.
1.	 Do one of the following:

�� Connect the mini-USB end of the USB cable (not supplied) to the recorder and the 
other end to a USB port on your computer.

�� Remove the memory card from the recorder and access the card on the computer 
via a card reader.

2.	 Start MiVue Manager on the computer.

Exit

MaximiseMinimise

Calendar

File type

File list

Video playback 
screen

Playback 
controls

Map screen G sensor chart
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Note: The Map screen may not display when the computer is not connected to the Internet or 
when your Mivue model does not support the GPS function.
Note: G sensor chart displays data in 3-axis waveform about the car’s shift forward/backward 
(X), to the right/left (Y) and upward/downward (Z).

3.	 By default, MiVue Manager shows the calendar and the file list on the right. 

�� When a recording file exists, you will see the date marked with “▲.” Click that date 
to display the files that were recorded on that date.

�� You can choose the file type to display: Event (emergency event recordings) and/
or Normal (continuous recordings).
Note: Your MiVue model may not support the "Parking" file type.

�� To display all files in the current folder, click All. To return to the calendar view, 
click Calendar.

Calendar Calendar and File List All File List

You can also click  on the upper-left corner to select the folder that stores the 
recording files.

4.	 Double-click the desired file on the file list to start playback.

5.	 The playback controls are described as follows:

Icon Description

Starts or resumes the playback.

Pauses the playback.

／ Skips to the previous / next file on the list.

Changes the playback speed to 1/4x, 1/2x, 1x (default), 1.5x, or 2x.

Changes the playback direction. The ► icon indicates the current playback 
direction.

／ Mutes or unmutes the volume.

Adjusts the volume level.

Plays the video in full screen.

Returns to the normal view.

Displays the playback progress. You can click on a point 
along the track bar to move directly to a different location 
for the playback.

6.	 The tool bar allows you to do the following:
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�� Click  to preview and print the current video image.

�� Click  to back up the selected files to the specified location on your computer.

�� Click  to capture and save the current video image to the specified location on 
your computer.

�� Click  to export the GPS information of the selected file in the KML format to 
the specified location on your computer.

�� Click /  to upload the selected file to Facebook or YouTubeTM.

�� Click  to open the Settings menu. (See the next section.)

Settings menu
Click  to open the Settings menu. The Settings items are described as follows:

�� Change Language: Sets the display language of MiVue Manager.

�� Change Skin: Sets the color scheme of MiVue Manager.

�� Check for Update: Checks if there is any new version of MiVue Manager.
Note: Internet access is required for this feature.

�� About: Displays the version and copyright information of MiVue Manager.
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Reference
What is GPS?
The Global Positioning System (GPS) is available at any time, free of charge, and is 
accurate to within 5m (15ft). GPS navigation is made possible by a network of satellites 
that orbit the Earth at around 20,200km (12,552mi). Each satellite transmits a range 
of signals which are utilized by GPS receivers, such as your Mio, to determine an exact 
location. Although a GPS receiver can detect signals from up to 12 satellites at any time, 
only four signals are required to provide a position or "GPS fix" (latitude and longitude), 
for vehicle navigation systems.

How does my Mio receive GPS signals?

Your Mio receives GPS signals via the internal GPS antenna. To guarantee the optimum 
GPS signal strength, ensure your Mio is outdoors, or in a vehicle outdoors, and has an 
unobstructed view of the sky. GPS reception is not usually affected by weather; however, 
very heavy rain or snow may have a negative effect on your reception.

Caring for your Mio
Taking good care of your Mio will ensure trouble-free operation and reduce the risk of 
damage to your Mio:

�� Keep your Mio away from excessive moisture and extreme temperatures.

�� Avoid exposing your Mio to direct sunlight or strong ultraviolet light for extended 
periods of time.

�� Do not place anything on top of your Mio or drop objects on your Mio.

�� Do not drop your Mio or subject it to severe shock.

�� Do not subject your Mio to sudden and severe temperature changes. This could cause 
moisture condensation inside the unit, which could damage your Mio. In the event of 
moisture condensation, allow your Mio to dry out completely before use.

�� The screen surface can easily be scratched. Avoid touching it with sharp objects. Non-
adhesive generic screen protectors designed specifically for use on portable devices 
with LCD panels may be used to help protect the screen from minor scratches.

�� Never clean your Mio when it is turned on. Use a soft, lint-free cloth to wipe the 
screen and the exterior of your Mio.
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�� Do not use paper towels to clean the screen.

�� Never attempt to disassemble, repair or make any modifications to your Mio. 
Disassembly, modification or any attempt at repair could cause damage to your Mio 
and even bodily injury or property damage and will void any warranty.

�� Do not store or carry flammable liquids, gases or explosive materials in the same 
compartment as your Mio, its parts or accessories.
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For more information
Online support
For 24/7 help and support with Mio products, visit our Technical Support website at: www.
mio.com

Mio Advantage
If you have a faulty product or you would like to speak to a member of our Technical 
Support team, register your Mio on Mio Advantage to obtain the Technical Support phone 
numbers for your region.
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Revision: R00
(4/2015)

Trademarks
All brand and product names are trademarks or registered trademarks of their respective 
companies.
Disclaimer
Specifications and documents are subject to change without notice.
Speed Limit
Mio products are designed to be used as an aid to safer driving. Mio does not condone 
speeding or any other failure to comply with your local traffic laws. It is your responsibility 
to drive within the posted speed limit at all times and to drive in a careful manner. Mio 
accepts NO liability whatsoever for you receiving any speeding fines or points on your 
license through using this device. Mio does not guarantee the accuracy of the data 
contained within this database either expressed or implied. In the event you receive a fine 
or any other penalty for speeding or contravention of any traffic law, or are involved in an 
accident, Mio is not responsible for any damages of any type. In some countries the data 
information regarding speed limits may conflict with local law and/or regulations. It is 
your responsibility to make sure that your use of the data is in compliance with local laws 
and/or regulations. Usage is at your own risk.
Safety Camera POIs
Mio products are designed to be used as an aid to safer driving. You can receive messages 
to alert you to locations of safety cameras, which will enable you to monitor your speed 
through these areas. Mio does not warrant that all types and locations of safety camera 
data are available, as cameras may be removed, relocated or new cameras installed. Mio 
does not condone speeding or any other failure to comply with your local traffic laws. It 
is your responsibility to drive within the posted speed limit at all times and to drive in a 
careful manner. Mio accepts NO liability whatsoever for you receiving any speeding fines 
or points on your license through using this device. Mio does not guarantee the accuracy 
of the data contained within this database either expressed or implied. In the event you 
receive a fine or any other penalty for speeding or contravention of any traffic law, or 
are involved in an accident, Mio is not responsible for any damages of any type. In some 
countries the data information regarding safety or speed cameras may conflict with local 
law and/or regulations. It is your responsibility to make sure that your use of the data is in 
compliance with local laws and/or regulations. Usage is at your own risk.
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